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Befoicddvw ot1 giuar o ovyypapéas avtis s epyociog kot 0Tl kdbe fonbeia thy omoia giya yio Ty TPoETOL-
HaoTo. TS EIVAL TANPOS AVAYVWPIOUEVH KOL AVAPEPETAL OTHY Epyooia. ETions, Exw Katoypayel Tic OmoIES
TNYES ATO TIG OTOIES EKAVO. YPHTT OEOOUEVV, IOEWDV, EIKOVWY KOL KEWEVOD, EITE ODTES OVAPEPOVTOL OKPI-
Pag eite mopappoouéves. Emmiéov, Peforcove Otr avti 1 epyacio IpoETOLCOTHKE A0 EUEVO, TPOOWTIKG,
e10tka w¢ ormdwpotixy epyacia, oto Tunuo Myyovikav Inpopopikng kor Hiektpovikav Zvoatqudtwy tov
ALIIA.E.

H mapodoa epyooio amotelei mvevpatixny 1dioxtnaio tov povrnty [loviion Myyonl wov v ekmovnoe. Xto
TAaio10 THS TOMTIKNG OVOIKTHG TPOCLOGNHS, O GUYYPOPEaS/ONuIovpyos exywpel ato Aiebvég Ilaveriotiuio
¢ EALGdog adeio yprong tov SIKaMUATOS OVATopaymyns, JoVELTUOD, TOPOVTIOcHS 0TO KOIVO Kol Y-
PIOKNG OLOYVONS THS EPYATIOS OLEOVADG, & NAEKTPOVIKI] LOPPH KOl O€ OTOI00NTOTE UECO, VLG OLOOKTIKODG
KO EPEVVNTIKOVS OKOTOVG, Avey avtaliayuoros. H avoixtn mpoofoon oto mlipes keiuevo g gpyociog,
oev onuaivel ko’ 010VONTOTE TPOTO TOPOYWDPNON OKALWUCTWV OLOVONTIKNG LOIOKTHOIOG TOV GUYYPOPE-
a/ONUIOVPYOD, 0UTE ETITPETEL THY AVOTOPAYWYH, OVOONUOTIEDGH, OVTIYPOPY, TWANGH, EUTOPIKN XPHOH,
oavoud], éxdoon, ustapoptwoy (downloading), avapthon (uploading), uetappoon, wpomomoinon ue o-
TOI0VONTOTE TPOTO, TUNUOTIKG. § TEPLANTTIKG. THS EPYATLOS, XWPIS TH PHTH TPONYODUEVH EYYPOPN TOVAIVETH
TOV GOYYPOPEQ/ONUIOVPYOD.

H éyxpiom g dimhopatikng epyaciog amd to Tpqpa Mnyavikov [TAnpogopikrg kot Hiektpovikdv Xv-
otV Tov Aebvoig Iavemotnuiov g EALGSOC, dev LVTOINADVEL ATOPALTHTMS KOl OT0d0Y TOV
OTOYEWMY TOL GLYYPOELQ, €K LEPoVS Tov Tunpatog.



«Agiépwony
2rovg yoveig nov (Twpyo, Koiiionn) kor ora 0déppio. ov(@odwp, Niko)!






Iporoyog

O AOyog mov emérelo TV CLYKEKPLUEVN epyacia sival 0Tt Bewpd Twg o cuvdvaouodg hardware kot
software pumopet va épet dmelpovg GLVIVAGIOVG GTOVG 0Tol0g pmopel vo enweeieldel o Kabévag pag.
Eival evionooiokd mov 1 kabe pikpn ovtopoatomotnuévn dnuovpyio pmopel vo, PEATIOGEL TOV TPOTO
{®N¢ KATO10V KOl VoL TNV O1EVKOADVEL.
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Hepitnyn

H ovykexppévn perémn mpoxettor yio pio Epevvol Kot VAOTOINGT eVOC GUGTHHATOG EELTTVOL GTLTION TOV
Oa Ponbnoel Tov avayvmdoTn Vo KATOVONGEL KAADTEPO 0VTH TO. cLOTH T 1] B TOV WO GEL VoL dnpLiovp-
ynoet éva 016 tov. O cvvovaoudc hardware kot software pmopei vo Log 0MGEL ATEPOVG GLVIVAGUOVG
KoL EQEVPETIKOVS TPOTOVE DOTE 0 AvOpTOC va cuveyilel vo TPoodeveL 1) va Pedtidvel Tov Tpomo {ong
tov. 'Evo cuotnpo €£umvou omtition, S1eVKOADVEL TV KOO UEPVOTNTO TOV YPNOTN, EKTEADVTOG dlEPYATI-
£G OMOLLOKPVOUEVA YMPIC VA ATOLTELTAL 1) QUGTKN TOV TAPOLGIO GTO GMITLT TO 1010 TO GVGTN O TIG EKTEAEL
avaAoya [E To TPOTO GYESOGLOV TOV N TG TPoUToBEselg mov £xel Béoet o id10g 0 ¥pNoTNG.



«Smart Home System»

Pavlidis Michail

Abstract

This project is about researching and constructing a smart home system to help the reader understand
those systems much better or exhort him to make one of his own. The combination of hardware and
software can give us infinite combinations and creative ways so that humans keep progressing and
improving their way of life. A smart home system can make the user’s life easier, as it accomplishes
processes remotely without the user being in the house. The processes can be executed automatically
depending on how the system is made or the user’s needs.
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Evyoprotieg

Onwg kot otn {on €161 KoL 6 [G SIMAOUATIKY €pyocio dev eival EDKOAO va emitevydel kAT Ywpig
VoL VTAPYEL OTOLONTOTE HOPPY| GTAPIENG O pia opddo avBpdrmv mov eptBdiel to dTopo. Av Kot
ot N gpyacio vAomoonke amd tov cuyypagéa g Oa gival ayévela va unv avaeepbovy Ta dToa TOV
Bonbnoav, Eropévog e autd to Koppdtt 0EA® TpocmmTIKA Vo evYapIoTHGM 060 GTopa £xovv otabei
pali pov kot pe yovv otnpiet Oyt LOVO KATd TNV SLAPKELD TNG TPAYLOTOTOINGNG AVTNG TG EPYACIOG
0AAG Ko oty duapkela g Long pov.

EeKIVOVTOG BEAM VO ELYOPLOTNO® TOVE YOVELG LoV TTOL L otnplEay Kot pe otnpilovy pe 1d60Vg TPOTOVS
OV OKOHO KO OVTES 01 AEEELS OV elfvan OPKETO Y10l VO TOVG T EVYAPIOTA Yot OAN TNV VRLOGTNHPLEN TOV
pov £dmoay KaBOAN TNV SPKELD TIG AKOINUUIKNS Lov (ong.

Ta adéppra pov mov ektdg and adépeia VENPEAY PIA0LKOAANTOT Kol GLYKATOIKOL TOV OKOLLO KOL OV LLOG
yopilovv aroctdoelc yMopétpav Eépovpe 6Tt Ba gipacte dimAa o évag yia Tov GAAO.

Tov [Mammod pov Beddwpo kat v I'ayid pov Awpobéa mov pov vrevbupilovv cuvéyela vao falo Tov
KoAOTEPO OV €£aVTO GE OTL KAV® Yo VO TPOo0dEVG® otnv {m.

Metd v okoyévela BEA® va EVYOPIOTHOM TOLG KOAANTOVS Kal cuvadedpovg Baciieio Kovkoyidpyo
kot Nikorao Toakipn Tov YVOPIGTAKALE KOl OL TPELS OTIV 0PN TOV OKOSNUAIKOV pog ypOVOV Kot Lo
péBave (Kot akopa [ov pobaivouv) Tmg v tpoodebom otov topéa g [IAnpopopiknig.

Emiong va evyopiotiom v Etaipeioc Ham Systems kot 6An v opdda tng, Hiog Kot Lov dMCOvE TNV
gvkatpio va epyaotd pali Toug Kot Tapelyoy YVAOoES & DAKE yio TNV EXLTEVEN VTG TG EPYUCTOG.
Téhog va evyap1oThom Tov eMPAET®V kKabnynt pov K. Ayyeho ['lakovpn Tov cupedvnoe vo viorom el
ot M epyosio Kot vanpée cOOTA TNYN TPOCHNKNG TEPLEYOLEVOL GE QTN TNV EPYATIA.
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1 Introduction
Chapter 1: Introduction

1.1 Smart home

A smart home system is known as a home setup where devices can be controlled automatically or remotely
by the user. The devices used in a smart home system are connected through the internet and the user
only needs an internet connection or a network device (a device that connects the rest) to gain access and
control his home devices [1]. A smart home can be set up through wired or wireless systems, which can
be convenient and money-saving for the user [2]. The user has the opportunity to gain information or

control functions that can be:

« Temperature and humidity'

* Lighting

* Heating

* Audio & Visual

* Security Surveillance

* Monitoring Energy consumption

 Taking care of a pet by providing it with food and water

Homes Are Only Getting Smarter

Estimated number of households worldwide
with the following smart devices (in millions)

W 2022 W 2027
I 1314

Smart speaker 3353

I 77.5

Smart security camera 180.7

I 731

Smart big appliances 177.6

. 72.2 .

Smart small appliance

|
172.1 ( >
Smart smoke detector NI 48.4 116.2 A Rl

B 393

Hub/gateway 55.2

Figure 1.1: Smart home devices and applications per household are predicted to increase
Source

Thanks to smart home systems, the user can control his home devices and appliances remotely.

"Humidity is the concentration of water vapor in the air


https://www.weforum.org/agenda/2022/04/homes-smart-tech-market
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1.1.1 What is a smart device

A smart home system needs smart devices connected to each other or connected to a network that uses
wireless protocols (WiFi or Bluetooth). But what makes a device smart?

1. Context awareness: The device has to gather information about its environment, and according

to that data, the device has to act accordingly.
2. Autonomous computing: The device can perform tasks without the direct command of its user

3. Connectivity: The device can connect to a network (wired or wireless). This is important since a
device without connectivity would be useless for context awareness and autonomous computing.
While most smart devices do not require human interaction, we must consider that most do. A
smart device can have a direct (smartphone) or indirect (temperature) probe interaction with its
user, but what matters most is that, in the end, the user will use the device’s data. A smart home
system can make the user’s life easier since many functions can be done automatically. Moreover, it
can reduce unnecessary electricity usage and, as so, reduce cost, which is energy related. To create

a smart home system, we need to create a way to get information or control them remotely. [3]

1.2 History of smart homes

1.2.1 Before smart homes

il
15 3
11 —r7

9

UNIT

B,
0wy C
ME
K—r’e

HOUSE

Lamp Module

R —

Figure 1.2: One of the first X10 products: A remote lamp controller
Source

While the terminology of the smart home did not exist yet, in the 1900s, with the introduction of electric
power distribution, the first electric devices were made to save time in-home labor. Thanks to electrical
devices such as washing machines, water heaters, and refrigerators became the first devices of home
automation. These home devices were not considered smart since their users had to adjust them to work,
but thanks to electricity, they were the first autonomous devices that did not demand a massive human
effort to function. [4]


https://www.x10.com/products/lm465
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1.2.2 The first smart home system

[5] Years later, in 1975, in Scotland, Pico Electronics developed and released X10, a general-purpose
home automation platform still in use today. Back then, this platform sent digital data through radio
frequency bursts to the house’s electrical wiring to remotely control home devices.

The first home automation system arrived in households, however, these systems were expensive, and

they had many issues, such as:

* Slow response times
» Unencrypted data
+ Signal loss and interference if a neighbor had the same system.

» System relied on heavy power lines

1.2.3 Millennium era

Figure 1.3: The Zigbee module was one of the first wireless- low power technologies for personal area
networks
Source

In the early 2000s, most smart home problems were solved thanks to Z-wave and Zigbee wireless tech-
nologies. While both technologies can offer many features for a mesh network, they have the edge over
the other in different categories. Zigbee devices can be faster and handle more devices in a mesh net-
work, but Z-Wave does not interfere with WiFi and demands less power to run [6]. Both technologies use
different radio frequencies (Zigbee 2.4GHz - Z-Wave 908.42MHz), which can be affected depending on
the type of devices we connect. When both of them were released in public, it was the era in which most
security protocols were made since these devices have AES-128 encryption currently used in financial
institutions. Thanks to Z-wave and Zigbee, everyone could have access to that technology without the
need to use cables. Lastly, these wireless technologies provided enough bandwidth to connect multiple

devices and control them remotely, which previous technologies struggled with.


https://ubuntu.com/blog/the-evolution-of-the-smart-home-how-it-started-part-1#:~:text=Smart%20home%20technology%2C%20as%20we,modules%20installed%20in%20the%20home.

Chapter 1

1.2.4 2010

After 2010 many major companies started getting interested in smart home systems. One of them was
a new company called Nest Labs, created by an ex-engineer of Apple, Tony Fadell. Fadell managed to

build Wi-Fi devices such as smoke alarms (Nest Protect) and thermostats (Nest Learning Thermostat).

il

COOLING ol

68 |

4

Figure 1.4: A Google Nest Thermostat monitors and controls room temperature
Source

Later on, Nest was bought by Google, making new versions of the previous devices and introducing new

smart home products such as:

» Nest Cam Indoor: This device was made for indoor security surveillance, featuring excellent video
resolution, night vision, and motion alerts. Moreover, this device had atwo-way talk feature, which
allowed the user to talk and listen through the camera.

* Nest Cam Outdoor: Like the indoor version, this one was made for outdoor surveillance, as the
design was made to endure outdoor conditions.

* Nest Cam IQ: This product is an upgraded model of the Nest Cam Indoor, as it features a 4K
camera sensor with HDR. Also, this camera was equipped with advanced artificial intelligence,
which could differentiate people from moving objects and recognize human faces.

* Nest Secure: This system is an alarm system that includes three different devices:

— Nest Guard: Allows to turn security on and off, detects motion, and sounds the alarm.

— Nest Detects: It is installed on a door or window and informs the user when it is opened or
closed.

— Nest Tag: Turns the alarm on and off by using it on Nest Guard.
This system could also be controlled by using the Nest app, allowing the user to arm or disarm the

alarm and get a notification if the user forgot to set the alarm or if some activity was recorded when

the user wasn’t at home.


https://www.cnet.com/home/smart-home/googles-smart-home-ecosystem-is-a-complete-mess/
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« Nest Doorbell’>: This device functions as a doorbell with facial recognition. Like the Nest Cam
products, Nest Doorbell detects motion and allows the user to talk and hear others in the sight of

the camera.

1.2.5 2012

Two years later, smart devices could be controlled and monitored with an application called SmartThings
which 2014 was bought by Samsung. The Smart things app was the first certified platform that allowed
users to control and monitor the devices’ energy usage in real-time. Thanks to this mobile application,

devices registered on a server could be controlled remotely, from home appliances to TVs and speakers.

5 Works with .
oo SmartThings

O =
—— u
TV Washer/Dryer Robot Vacuum
o
5 0O e
Refrigerator Wi-Fi Hub Motion Sensor
Light Bulb Lock Thermostat

Figure 1.5: With the Smart Thing application we can control devices and automate home applications
Source

ZKnown as Nest Hello when it was first released
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1.2.6 Nowadays

Today smart home systems are available and open-source to anyone despite their knowledge of smart
home technology. Open-source projects such as HomeAssistant, OpenHab, and Calaos [7] allow tech-
nology enthusiasts to create their systems by their criteria. These open-source systems run on a local
server (most use Raspberry Pis) and use libraries for the connected sensors and devices. Companies have
started producing and selling products, and even individuals can make their systems, depending on their
needs to experience a more comfortable way of life and have more sense of control in their household.
As numerous companies are created or start to get interested in home automation, some companies have

won customers, with their products being used daily, such as:

* Google Home
* Amazon Echo

* HomePod (Apple)

Home Assistant E

H Family Room
:\Rf ":F"Te NEXT DEMO -~ 5 ¥ 5 .
s I Wasn't Born To Follow ecurity
B Upstairs The Byrds
Welcome home! You've reached the Home
Assistant demo where we showcase the 22C
best Uls created by our community. < 0 » . ARM HOME
20:24 ) -
LEARN MORE ABOUT HOME ASSISTANT Auto - Away
= .
Liahts 2 = Information
9 Entertainment
° (=] Morning Commute 37 min
Kitchen lights
N 9 » @ Harmony YouTube
f  Commuteto Home 41 min
®  Living Room Lights » reiot
- = ctivity
@  Plexspy 0 Watching B vYouTube
¥ Porch Lights »
$ USDINR 7125INR = HDMI Switcher
Garage lights ® 8 Shied
=  HOMIinput
B InputHdmia

Doorbell
o) Volume s

U far  Front Door Ding Clear
|~ Total TV Time 0.42h

. 2 Front Door Motion Clear

Figure 1.6: An example using the open source Home Assistant System
Source

1.3 Research on Smart Homes

According to research, people believe using smart home systems has improved their lifestyle by having
control of their houses. As most smart home systems are installed by US companies (with China ranked
second), by 2025, the number of smart homes used worldwide is forecasted to increase to 480 million [8].
Moreover, it is confirmed that many people would think of installing a smart home system, as younger
people state that they would pay 20% more to have remote control in their houses [9]. Thanks to smart
home technology, many products and devices are being used by elders with health issues who can control
these devices even by using voice activation. As smart home systems are applied, a significant percentage
of people affirm that they can save time and money by reducing unnecessary energy consumption from

heating or cooling systems. Moreover, most users would invest in smart home security, from cameras


https://medevel.com/17-home-automation-open-source/

1 Introduction

Global Smart Home Market is Expected to Account for
USD 680.90 Million by 2029
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Figure 1.7: Since there is an increase in the smart home market, the demand from customers is going to
increase
Source

that can be monitored remotely to smart locks that can be opened and locked by the user. Additionally,
the user feels fulfilled when he monitors his house remotely and feels safer. Companies that sell smart
home systems produce devices that are isolated from the rest in case of a cyber-attack so that the threat
will not spread quickly to the rest of the system. [10]
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Chapter 2: Hardware & Software

2.1 Arduino IDE

The Arduino Integrated Development Environment is a coding tool to program Arduino or other mi-
crocontrollers. The Arduino code (sketch) will be compiled and uploaded to the microcontroller. The

microcontroller will translate the language of the sketch, and then it will remain in the board’s memory.

The Arduino code is written in C++ using functions that do not exist in other programming languages

and are necessary for Arduino sketches which are:

1. Setup(): The setup function is responsible for defining the board’s initial state, pins, and other
variables. After the sketch is uploaded to the board, all the coding inside this function will run only
once, but they can change values with the loop function.

2. Loop (): In this function, the code runs in a loop infinite times after the setup function is complete.
Using the Loop, we can determine which values we want to manipulate or which actions can be

done.

In the Arduino IDE, we can use libraries to control the hardware we will use. A library is a folder
containing files with C++ (.cpp) code files that hold the function implementation and header files(.h)
which describe the structure of the library and is used to declare all variables and functions. Arduino IDE
has installed a few libraries, but not the ones we will use. There are two ways to gain access and use

them:

1. Search them using Sketch > Include Library > Manage Libraries

2. Download them from a third party and include them using a .zip file.

2.1.1 Libraries used in code
* WiFi
* PubSubClient
* SHTSensor
+ SPI
* MFRC522
+ ESP32Servo
* IRremoteESP8266
* IRsend

* ir_Gree
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2.2 ESP32

An ESP32 is a low-cost - low-power Microcontroller with integrated Wi-Fi and dual-mode Bluetooth
(Bluetooth 4.2 and low energy). Espressif Systems create this Microcontroller with a series of SoC.
ESP32 is the descendant of ESP8266 and a much better microcontroller, as ESP32 includes an extra core,
faster Wi-Fi, and more GPIO pins. ESP32 has an operating frequency of up to 160MHz and has an Xtensa
Dual-Core 32-bit Microprocessor. It has 48 pins, of which 10 of them are not exposed, leaving us with
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Figure 2.1: ESP 32 Pinout
Source

38 visible pins (depending on the version we choose). Since we have chosen an ESP-32 development
board, 2 of its pins offer voltage of 3.3 and 5V separately. Moreover, the pins can be assigned different
functions, which will be decided in the code. In summary, the ESP32 pins are:

* 18 Analog-to-Digital Converter channels

3 SPI Interfaces

3 UART interfaces

2 12C interfaces

16 PWM output channels

» 2 Digital-to-Analog Converters

2 128 interfaces

* 10 Capacitive sensing GP1Os
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2.2.1 USE ESP-32 on Arduino IDE

While Arduino IDE does not have a debugger, the user can exploit the serial monitor to monitor the values

of the variables and detect any anomalies in his code.

As the Arduino IDE officially supports its official microcontroller boards, we can install other boards,
like ESP32, to program them. In File>Preferences, we enter the following line: Afterwards, we search
the:

Tools>Board>Board manager

for ESP32 by Espressif Systems and install it. To test if we can upload to our microcontroller, we have to
connect it to the PC that runs Arduino IDE using a USB cable. Next, we choose from the programming

environment the USB port the microcontroller is connected to, and then we choose the board ESP-32.

2.3 Raspberry Pi

Raspberry pi is known as a single-board computer created by Raspberry Pi Foundation. The Foundation’s
primary purpose was to encourage individuals (despite their knowledge) to get familiar with computing
or get used to programming. However, Raspberry pi is now used for different applications to such a point

that even industries use them since it is a low-cost computer that operates in an open-source ecosystem.

Figure 2.2: Raspberry pi 4
Source

As we mentioned before, most people use them to get familiar with Computer Science, mainly in pro-

gramming. However, those experienced in that department can use it for electronic coding devices for
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physical projects, and one of those projects can be a Smart Home system. For this project, we use a
Raspberry pi 4 with 2GB RAM, which is faster than prior Raspberry pi models since it has a 1.5-GHz
Broadcom CPU and a faster MicroSD card slot with an operating system running. In this project, the
Raspberry pi will be used as a server, and it will run Node-RED and a communication protocol known
as MQTT. [11]

2.4 Node-RED

Node-RED is a programming tool to connect the hardware devices and sensors with our server to get the
data or use the devices remotely. It is a useful open-source tool for building IoT applications like ours.
Node-RED runs on the web browser, and with the assistance of visual programming, we can connect
nodes, known as code blocks, to achieve a task by receiving Payload messages. With Node-RED and an
MQTT protocol, we can establish a connection with our ESP32. As we use Node-RED, we will construct
a dashboard that is visualized using JSON programming language to view our home conditions, such as

temperature or humidity, and even control some of our hardware, like lighting or our pet food container.

2.4.1 Having Node-Red on Raspberry Pi
To install Node-Red on Raspberry Pi we need to enter the following line in a terminal:

bash <(curl -sLhttps://raw.githubusercontent.com/node-red/linux-installers/master/deb/update-nodejs-

and-nodered)

After the installation, it would be preferable to configure Node-Red by using the command:

node-red admin init

Which, we can set up a security system by adding a username and password, after that we have to make

Node-Red run automatically when the Raspberry pi boots up, using the command:

sudo systemctl enable nodered.service

To access the Node-Red, we type the Raspberry’s IP address followed by:1880 and log in with the user-
name/password credentials we set before. After gaining access, we can use Node-Red to create nodes

and connect them with flows to perform tasks that will be required in our project.

In order to view the data from the devices or interact with them, we need to build a Ul that Node-Red
can provide by using a dashboard. By going to Menu>Manage Palette, we search for node-red dashboard
and install it. The dashboard can be accessed by adding /ui in the URL address of the raspberry pi’s IP,
which will look like this:

http://Rasbperry-Pi-Adress:1880/ui

11
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=<2 Node-RED

Node-RED

Figure 2.3: Node RED requires login credentials in order to create nodes and flows

Afterwards, we can edit the layout of the dashboard and arrange it however we want.

While we can use just our personal computer, our dashboard is considered a local site, and we cannot gain

access remotely. However, Node-RED offers a proper tool to access our website locally and remotely.

2.4.2 Remote Red

Remote RED is a tool that allows us to access the dashboard using our smartphone. Since we live in
times where a smartphone is required wherever we go, we could use it to view and control our dashboard

remotely without the need to be in the same Wi-FI network that our MQTT broker is connected.

By installing the Remote-RED package with this command:

node-red-contrib-remote

We have to add a node known as a config node for the page we want to access and configure it. With this

Node we can define settings like:

1. Name: The name of the page which will be displayed in the app.
2. Serving host: The local IP of the host whose Ul is to be shared.
3. Protocol: The one which is used by the web server (HTTP)

4. Serving Port: The port that will be forwarded (1880)

5. Base URL: The initial page to be called

6. Server location: The server which will tunnel to the localhost. We have 3 options depending on

our region:

* Europe: Germany

» Asia: China

12
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¥ Name My Home

© This name will be displayed in the app.

£ Serving Host | localhost
localhost = Host of Node-RED. (s internal use

% Protocol http w
W Serving Port | 1880

¥ Base URL fui

@ Server
location

Figure 2.4: Using these configures we can use the Remote RED app with our smartphone

e America: USA

These servers create a tunnel to our local server/site, and we can open the Dashboard UI with our smart-
phone by installing the remote red application. After installing the application, we must connect our
smartphone to the dashboard UI. In order to do that, we need to add a Node-Red Instance from our smart-
phone. An instance is a connection to the config node we are using in our dashboard. The application
will demand a QR code which can be found in the config node settings. After scanning it, we can have

access to the dashboard.

Additionally, with Remote red, we can program notifications (push notifications) to appear on the phone

whenever necessary.

Using the notification nodes, we can optimize the title and the text of the notification, and at the time a

message arrives at the notification node, the notification we configured is going to be seen on the device

2.5 MQTT

It is a standard messaging protocol that is very popular for IoT applications [12]. It is a simple and
lightweight messaging protocol designed for devices that use minimal network bandwidth and connect
them remotely, making it perfect for our project. We use the MQTT protocol so that our ESP-32 and
Raspberry Pi exchange data with each other and control our devices. The reasons why we choose the
MQTT protocol are:

13



Chapter 2

spiceworks
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Figure 2.5: A simple explanation on MQTT
Source

1. Efficient with minimal resources
2. Easy to use
3. Simple communication between devices
4. Two-way communication between the devices we use
5. Scalability with IoT devices
6. Reliability
The MQTT protocol is not based on traditional client/server communication, but MQTT is built around

an architecture that needs several devices to exchange data with each other in the form of topics. These

devices are known as Clients and Brokers.

* Clients: A client can be any device (ESP 32) or tool (Node-RED) that connects to the broker.

Clients cannot connect and do not communicate directly with each other. Precisely the data ex-

14


https://www.spiceworks.com/tech/iot/articles/what-is-mqtt/

2 Hardware & Software

change between devices can be accomplished by a proxy which in the MQTT protocol is known

as a broker.

* Broker: The broker receives the client’s request to receive data from one or multiple topics, and it

acts as a proxy, making sure to receive or transfer data to the client.

Topics can be multiple, and we can specify how we want to receive that message. The topics are repre-
sented with strings separated by a forward slash, with each slash representing a topic level. The devices,
however, need to be established in what topics they need to receive/send data, and the broker has to be
configured so it knows where it needs to send the topic’s data. For that reason, MQTT uses the publish/-

subscribe method.

PUBLISH PUBLISH
ESP-32 MQTT BROKER NODE RED

Figure 2.6: Node RED publishes data to the topics ESP-32 has subscribed

* Subscribe: As we said above, the clients do not connect directly with each other. In order to
receive messages, the client needs to subscribe to a topic; to do that, the client has sent a Subscribe
request to the broker. After the broker responds with a confirmed message that the subscription is

acknowledged (known as SUBACK) it handles the client’s subscription topic(s).

* Publish: In order to send or receive data, the clients need to publish the data to the broker in the
form of a topic. As the broker receives the data, it checks which clients have subscribed to this

topic and transfers the data to those who have subscribed..

EUBLISEH PUBLISH

/\

ESP-32 MQTT BROKER NODE RED

Figure 2.7: ESP-32 publishes data that can be viewed to Node RED

The MQTT broker is responsible for receiving all messages and sending them where they are meant to
be sent by publishing the message to the clients that have subscribed to the topic. In our project, we will

use an open-source broker made by Eclipse, known as Mosquitto.

2.5.1 Mosquitto Eclipse

[13]
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The Mosquitto broker is an open-source message broker made by Eclipse that implements the MQTT
protocol and is also known as a lightweight and practical broker used on devices such as single-board
computers or even full-functioning servers. Because it is lightweight, it can deliver messages competently
using the publish/subscribe model we mentioned above, making it perfect for IoT projects that use low-

power devices and sensors.

mosauitto

Figure 2.8: Mosquitto Eclipse is an open-source MQTT broker
Source

The Mosquitto broker is going to be installed in our Raspberry pi, using its terminal window. By running
the following command:

sudo apt update && sudo apt upgrade

Next, we need to configure the Mosquitto broker so that it will start automatically when the Raspberry
Pi boots by using this command:

sudo systemctl enable mosquitto.service

2.6 Relay module

A relay module is an electrical switch that can be activated by the signal of a microcontroller which can
activate or turn off a device connected to the relay. There are two led indicators to confirm if the relay
is working and if it is activated or not. The red one, which indicates the device’s power, turns on if the
relay is powered, while the other one (green) turns on whenever the relay is active, indicating the device’s
status and if current flows through the relay coil. [ 14] To ensure the connections are reliable, the devices
we want to control are screwed through terminal blocks, making wires difficult to solder connect directly.

A relay module has three pins that require connection with jumper wires:

e VCC: Which will be 5V.

* GND: Ground of the relay.

16
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Figure 2.9: A 1-channel 5V Relay module
Source

» IN: The digital input pin will be connected to the microcontroller.

Moreover, it has 3 terminal blocks to connect a device

* NO: Normally open means the relay’s switch will be open (The device is closed).
* NC: Normally closed means the relay’s switch will be closed (The device is open).

* COM: In the common terminal we connect the device we want to control.

We will use two relay modules of 5V for two devices which we will explain in the next chapters.

2.6.1 Office Lamp

While an office lamp is a simple device for lighting, it is an excellent example of how to remotely control
lighting devices (light bulbs or even led strips). In order to control the office lamp will require connecting
the lamp’s cable with the relay module. While an electrical socket will power up the lamp, one of the
wires of the lamp’s cable will be connected with the COM terminal, and it will be continued through the

NO terminal since, when our system boots up, we want the device closed.

2.6.2 Water pump

A water pump is used in order to flow water. Water pumps can be used in IoT applications, either small
(gardening) or large (agricultural purposes). For our project, we will use a water pump to provide water
for our pet. The water pump we will use is a low-cost one that requires 2.5-6V DC voltage. This water
pump will be placed in a reservoir” full of water, and because the pump is submersible, it can be placed
inside the water (the water levels have to be higher than the pump). Using a water level module (which

17
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we will explain in chapter 2.11), we will measure if the water levels are high enough so that our pet will
have enough water for the day. The water pump positive wire is connected with a relay module to the
NO terminal, so the default behavior of the pump will be off when not used. The COM terminal and the
negative wire of the pump are connected to a 9V battery snap connector, where a 9V battery will power

the pump.

Figure 2.10: The water pump is deployed when the water level is low
Source

2.7 SHT 40

Measuring the temperature and humidity of the room is expected in smart home systems. The user needs
to know the conditions of his home so that the user can heat or cool his home and even stop devices
that can change the temperature (A/Cs or thermostats) so that energy consumption can decrease and save

money. In order to measure the conditions of the room, we are going to use an SHT40 sensor probe.

Figure 2.11: An SHT 40 Probe for temperature and humidity measurements
Source

This is a sensor made from Adafruit in the form of a probe that can detect the temperature and humidity of
the area in which our sensor is deployed. This device uses a chip-to-chip protocol known as 12C, which
helps communicate with low-speed peripherals. Moreover, the power supply of this sensor ranges from

3.3V-5V, and it can measure humidity and temperatures from -40 to 125 degrees Celsius.

* VCC: Operating voltage from 3.3V to 5V

* GND: Ground pin

18
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* SDA: Serial Data pin

* SCL: Serial Clock pin

2.71 DHT

Another great alternative for temperature and humidity sensors would be one of the DHT sensor series
(Another product of Adafruit). Either DHT11 or DHT 22 are excellent choices since both return almost
accurate temperature and humidity sensors, but DHT22 has better measurement ratings in a broader range
than DHT11. While the DHT22 is more accurate in humidity readings, it would be more efficient if

Figure 2.12: Both DHT sensors are used for temperature and Humidity readings
Source

we used SHT sensors since they have more precise measurements in both Temperature and Humidity

readings. [15]

2.8 MAGNETIC SENSORS

Figure 2.13: A magnetic door sensor can be used to alert us when a door or window is open
Source

Alternatively, magnetic locks are a simple yet effective way to increase security in a smart home system.
They can be used in doors and windows so that the user gets updated if he forgot them open or if there

is a breach so that the user will be informed about a possible break-in and an alarm will be triggered.
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Additionally, they can be used in refrigerators in case the user forgets the fridge door open so that the
food does not spoil. In our project, we will place the contact sensors at the apartment’s main door. One
is placed at the door, and the other at the door frame while connected to a digital pin of the ESP 32 and
ground. They create a magnetic field indicating that the door is closed when they are near each other.
When the door opens, the distance increases between them, and the magnetic contacts will separate,
breaking the magnetic field and detecting that the door is open. While it would be rational to use wireless
contacts, they are more easily worn. Additionally, wired magnetic contacts can draw power from the
microcontroller, and they do not need battery changing, unlike wireless Bluetooth sensors.

2.9 RFID

RFID, also known as Radio Frequency Identification, is a system that uses electromagnetic fields to
recognize and identify tags embedded in particular objects (cards or keychains). [16] RFIDs are helpful
for home security since they can provide access to the house and even disarm an alarm timer when the
user opens the door. An RFID needs two things to work:

1. An RFID tag: The tag is a device that contains a microchip that contains information. Since it has
no batteries it is considered a passive device and is powered by the RFID reader.

2. An RFID reader: The reader is used in order to read the tag

RFID Reader/Antenna

RFID Tag

Data

Figure 2.14: The RFID tag is powered up when it is nead the reader
Source

It is essential to mention that tags and readers contain antennas to communicate when they get close to
each other. When the RFID tag approaches the reader, the latter generates an electromagnetic field that
goes through the antenna of the RFID tag and powers up its chip. The chip sends its stored information,
including a 96-bit binary number; for simplicity, we use its hexadecimal form. This hexadecimal number
is transferred to the reader as another radio signal (backscatter). When the reader detects this phenomenon,

it sends the information to a computer or, in our case, to the ESP32.

20


https://www.sparkfun.com/rfid

2 Hardware & Software

2.9.1 MFRCS22
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Figure 2.15: An RC522 RFID reader
Source

This module, built by the NXP Company, is an integrated read-and-write card chip for contactless com-
munication and one of the cheapest and most reliable solutions. It also creates a 13.56 MHz electromag-
netic field to communicate with RFID tags. This module can be powered easily with the ESP-32 since
its voltage can be until 3.3V. An RC522 RFID Module has eight pins which we can see in table 2.1. As

Table 2.1: RFID PINS

VCC The pin which is responsible for the supply of power.

RST A reset and power down pin.

GND Ground pin

IRQ An interrupt pin that can alert ESP-32 when an RFID tag is nearby.
MISO This pin acts depending on the usage we will initiate.
MOSI An SPI input to the module

SCK Accepts the clock pulses provided by the SPI of ESP-32

SDA | Serial Data pin, that its behavior depends on how we will initialize it.

the table mentions,each pin has a specific role. Firstly the VCC pin gets a power supply from 2.5-3.3V
and with the GND pin we ground our module. The RST pin determines the module’s mode, as when it
goes low the module goes to power down mode and resets when the module’s signal is on a rising edge
the module resets. While we won’t use the IRQ pin we can notice that the MISO pin will act depending
on which mode we use (MISO, 12C, or UART). The same goes for the SDA pin which will be used as
signal input (SPI) rather than Serial data (I2C) or Serial Data Input (UART).

2.10 Servo Motor

A servo motor is a motor device that can be controlled by a microcontroller and it can rotate or push parts
that can be used in many applications (robotics or cameras). [17] The one we will use, the SG90 micro
servo motor, is a small motor that can rotate from 0 to 90 and 180 degrees. To give precise rotation,
we use PWM, a method to control digital devices, by producing analog signals, which means that the
signal wave can be high or low depending on the timing. Inside the servo, some gears make the outer
annulus gear turn. To make the gears turn, a DC motor is used, which is powered and controlled by the

microcontroller. The servo motor has 3 pins:
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Figure 2.16: A Micro Servo SG90 motor
Source

* VCC: 5V pin
* GND: Ground Pin

* PWM: This pin is controlled by the microcontroller, which controls the pulse.

Gears Position Potentiometer

DC Motor

Small Microcontroller
or Specialized Servo IC

Figure 2.17: Inside an SG90 Servo Motor
Source

We will use the servo motor to provide food as the motor will open and close to drop food onto the pet’s
plate. [ 18]

2.11 PIR

The PIR sensor (also known as Pyroelectric or IR motion) is an electronic sensor used to detect movement
through IR radiation [19]. The model we are using, HC-SR501 [20], is an inexpensive sensor and an
effective way to detect motion from 7 meters and; valuable they can detect human and pet movement as
both of them emit an amount of IR radiation (invisible to the human eye course) from their body heat,
which the sensor can detect by using a pyroelectric sensor to detect sudden heat energy change in the
environment. For that sensor to work, it must adjust to the temperature it is deployed. When a human
or pet moves inside its range, the pyroelectric sensor generates an electrical current, becoming a digital

output signal.

To increase the activity and effectiveness of the sensor, we use a type of lens known as the Fresnel Lenses.
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FRESNEL LEN

Contains a pyroelectric
sensor inside

TIME DELAY

Figure 2.18: An HC-SR501 PIR sensor
Source

2.11.1 Fresnel Lens

Fresnel lens, which was developed for lighthouses, is a compact lens that effectively reflects the light-
house’s light horizontally and vertically. [21]
This invention, made by the French physicist Augustin-Jean Fresnel was one of the giant leaps in light-
house lighting technology, as many ships managed to float safely from danger. While a lighthouse could
be built with only an ordinary glass lens, that would be impossible since it would require lots of resources,
which would not make it compelling enough.

Fresnel lens is a unique type of lens that consist of a series of concentric grooves etched into the plastic.
These grooves act as individual refracting surfaces that bend parallel rays and merge in a parallel beam
that can travel a long distance. [ 1 7] Fresnel lenses are used in the following ways [22]:

* Lighthouses

» Searchlights

Floodlights
* Traffic signals

* Decorative lights in buildings
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Fresnel Lens

“Passive Infra-Red”

Figure 2.19: A PIR sensor detects IR radiation from body heat
Source

Reflecting

Figure 2.20: Thanks to prisms the light can be reflected in a desired location
Source

* Cameras & Small projectors

In PIR sensors, Fresnel Lens is made of plastic that covers the pyroelectric sensor, increasing the effec-
tiveness and sensitivity of the sensor, which can see through that plastic and used as an IR filter.

2.11.2 Inside a PIR sensor

The PIR sensor has 3-pin which are:

* VCC: Voltage input from 4.5 to 20 Volt

* OUT: This is a 3.3V logic output. In a logic output, we have two results:

— LOW: No movement

— HIGH: Movement detected
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Figure 2.21: The Pyroelectric sensor inside the PIR that detects IR radiation
* GND: Ground connection.
Moreover, the sensor uses two potentiometers to adjust two parameters:
1. Sensitivity: The maximum distance at which the sensor will detect movement (ranging from 3-7
meters)
2. Time: It sets how long the sensor will remain in a HIGH state. The minimum is 3 seconds, and

the maximum is 300 seconds (5 minutes).

For our project, we will use two PIR sensors ... both will be deployed in a wall next to the door, with one
set on a high position of the wall and the other on a lower [23]. The reason is that when the higher PIR
detects motion, it will mean that a human is passing despite whether the lower is triggered. However,
when only the lower is triggered, our pet is in range of that sensor.

2.11.3 Ultrasonic sensor

Another alternative for detecting movement is using an Ultrasonic sensor. While this sensor does not
detect movement, it detects the closest objective in front of it and measures the distance between itself
and the object. An HC-SR04 is an excellent suggestion as it is low-powered and easy to interface. This
sensor uses two ultrasonic transducers; one acts as a transmitter and the other as a receiver.

The transmitter converts the electrical signal to ultrasonic pulses, which the receiver gets and produces
an output pulse which translates to the distance of the object or person in front of it [24]. Like the PIR,
the Ultrasonic sensor is powered up to 5V and has four pins:

* VCC: 5V output of our microcontroller
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Figure 2.22: An ultrasonic sensor sends waves with the transmitter that reflects back to the receiver,
measuring the distance
Source

* Trig: This pin triggers ultrasonic sound pulses, and when set HIGH, it initiates an ultrasonic burst.

* Echo: This pin remains high when the sensor transmits the ultrasonic burst, and when it receives
an echo, it goes LOW. The moment the sensor is HIGH, it calculates the time until it goes LOW,

and as a result, it calculates the distance using this mathematical function:

Distance = Speed x Time 2.1

¢ GND: Ground Pin

2.11.4 PIR vs Ultrasonic

Both sensors are valuable and practical when it comes to motion detection despite their different functions
to do. However, PIR sensors are preferable for general detection as ultrasonic can detect the object’s
exact location near it. Moreover, regarding security, security professionals consider ultrasonic sensors
low-security devices. An ultrasonic sensor can easily be tricked using materials to absorb the ultrasonic
pulses, such as bed sheets or animal fur [25]. Since our project uses motion detection to notice if our pet
is near the door, we prefer to use PIR sensors as they can detect sudden temperature changes in front of
the sensor. Lastly, the PIR sensor has a larger field of view and can be deployed in house areas where the

Supersonic sensor is inferior.
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2.12 Water Level Module

This module will be used inside the water container to measure how much water there is inside the
container. This module has ten parallel exposed copper traces, five of which are power traces, and the
rest are sense traces. This module uses both types of traces as a resistor to mention how much water there
is. The more the module and traces get deeper in the water, the more the resistance decreases, and the less

the sensor is immersed in water, the more the resistance increases [26]. This sensor generates a digital

Power LED

* Sense Traces
ssceessece ® Power Traces

Figure 2.23: A water level module uses copper traces to recognize the level of water in a container
Source

output depending on the resistance, and it is simple to use while it requires three pins:

» S(Signal): It is an analog output pin that will be connected through an analog pin of our ESP32.

* +VCC: This pin provides power to the sensor ranging from 3.3-5V; however, the analog output

depends on the sensor’s voltage.

¢ -GND: Ground Pin

213 MQ2

An MQ?2 sensor is considered one of the best and most widely used sensors to recognize and detect
chemicals in the air. Its reliability makes it useful for indoor air quality monitoring and can also be used
for fire detection. The sensor uses a Metal Oxide Semiconductor known as a Chemiresistor. It operates
on a 5V voltage supply and can detect the following:

1. LPG

2. Smoke

3. Alcohol
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4. Propane
5. Hydrogen
6. Methane

7. Carbon Monoxide concentrations

Figure 2.24: An MQ2 gas sensor
Source

While it is impressive that this sensor can detect such a high number, it can not recognize any of the
above, so it is preferable to measure the gas density of a specific room. The sensor is covered with
two layers of stainless steel mesh, ensuring that the inside element does not cause an explosion since it
detects flammable gasses. This mesh, known as an anti-explosion network, protects the sensor, filters out
unnecessary particles, and allows only gas to pass through. Inside the mesh, we can see six connecting
legs and a sensing element forming a star-shaped structure on the sensor’s base. Two of the six legs
are connected to a Nickel-Chromium coil inside an Aluminum Oxide Based Ceramic to keep the sensor
heated all the time.

Meanwhile, the remaining four legs connect with a Tin Dioxide coating, which is sensitive to combustible

gasses, and as a result, these elements are responsible for sensing gas elements. The sensor’s analog
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Figure 2.25: Inside an MQ2 sensor
Source

output changes depending on whether there is gas concentration. When the air is clean, the electrons
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from the tin dioxide are attracted to oxygen molecules outside of the sensor, forming a barrier of Oxygen
and electrons. As the electrons are far away from the coating of Tin Dioxide, the latter becomes highly
resistive, preventing electric current flow. However, the moment the sensor senses gas near itself, the
Oxygen reacts with the gas shrinking its amount, and the electrons return to the coating lowering its
resistance levels and allowing the current to flow through the sensor [27].

2.14 Flame Detection Module

Fire alarm systems are widespread to use in smart home systems. If there is a fire in the room, the user can
be notified and call the fire department, or the system can notify emergency services if the user cannot.
Moreover, as smart home systems can be customized, they can include a sounding alarm or activate a fire
suppression system. While we have a sensor to check for gas leaks or flame fumes, the MQ2 sensor cannot
detect flames. An IR Flame sensor module is a simple way to achieve that. This module is equipped with
an IR photodiode sensitive to IR lights. Flames emit levels of IR light that are not visible to the human
eye but can be detected by the IR led. When the IR led recognizes the flame, an Op-Amp checks for a
change in the sensor’s voltage. The default voltage output is 5V, meaning there is no fire, and when it

recognizes the flames, the output voltage will be 0V.

Figure 2.26: Fire Module
Source

2.15 IR Modules

IR technology is a wireless means of communication to control devices. In a household, many devices
use IR technologies such as TVs or A/Cs, and to control them, we need a remote control with an IR led
that sends a signal to the device, which corresponds depending on the signal received. Nevertheless, we
need the remote controller in the same area as the device we want to control. Using IR modules, we
will control air conditioning without needing to be in the same room or using a remote controller. To

understand how we will use IR and A/C, we must explain how it works.

2.15.1 A/C with Remote control

As mentioned above, the remote control has an IR led known as a transmitter, which sends pulses of
IR light (which flashes on and off thousands of times per second) translated as binary codes. These
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binary codes have a specific function (Power ON/OFF, for example) and are received by the IR (receiver)
inside the device we want to control. As the receiver gets the binary code, the device’s microprocessor

understands the command, which the remote control requests and the device executes [28].

2.15.2 IR Receiver module

Figure 2.27: An IR Receiver module
Source

To use an IR transmitter to send the signals to the device we want to, we need to know the exact signals
per function; also, it is crucial to learn which IR protocol is used to make it easier to decode the signals.
We connect the IR Receiver module with the ESP 32, and we use the library IRremote ESP8266 and
specifically the example code IRrecvDumpV2. To connect the IR receiver, we need to connect three

pins:

1. GND: Ground pin
2. VCC: 5V

3. OUT: The output we will authorize to a pin of ESP 32.

> Timestamp = 000020.705

> Library = v2.6.4

> Protocol : GHEE

> Code : 0x4CO0B205001200038 (64 Bits)

> Meag Desc.: Model: 2 (YBOFB), Power: On, Mode: 4 (Heat), Temp: 27C, ]}
> uintlé t rawData[139] = {9004, 4470, &70, 538, 6318, 556, 614, 166
> uintf t state[8] = {0x4C, Ox0B, 0x20, 0Ox50, O0=01, 0x=20, 0x00, Ox38}:

Figure 2.28: Using the remote control of the A/C we figure out that it uses GREE protocol
After we upload the example code to our ESP 32, we use the remote control of the A/C and press the

power on button while aiming at the receiver. The receiver will recognize the protocol being used and

extract the binary signal.
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2.15.3 IR Transmitter module

After we get the IR protocol, we can use an IR transmitter to send commands to our A/C. This module,
made by DFROBOT, contains a Light emitting diode, which generates an IR light with a I1mm to 750 nm
wavelength. [29]

For this module to work, it needs to be in the line of sight and at a proper distance from the A/C. As the
A/C receives the signal with its own IR receiver, it converts the beam of light signal to an electrical one,
and thanks to the integrated circuit of the A/C, it can execute the command it was given. The module
sends a digital wave signal to 38 kHz frequency and requires a 5V power supply. This module has three

pins:

* VCC: 5V power supply
* GND: Ground

» D: Digital input.

Figure 2.29: IR transmitter module made by DFROBOT
Source
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Chapter 3: Explaining The System

Now that we have explained everything related to the hardware and the software we are using, we will

see how all of those components work together and how they connect.

Figure 3.1: The complete electric circuit

3.1 Code explanation

Here we will explain how the ESP32 is connecting. After including all the libraries and initializing all the
variables and pins we will use in our ESP32, we set up the Wi-Fi and the [P address of the MQTT broker
to which the ESP32 will connect. After ESP32 is connected to the Wi-Fi, it will subscribe to the topics
and need to receive control orders from Node-RED. Afterward, the loop function will be run with the
sensors, or the state of the devices will be sent to Node-RED, which the user can view via the dashboard.

3.2 ESP 32 Connections

It is crucial to mention that ESP 32 and all its sensors will be deployed on a breadboard. While the
particular ESP 32 model we have chosen(DEVKIT 1°), has the potential to power 3.3 and 5V devices,
more is needed, as most devices powered up by 5V can interfere with the other devices, and give us false
information. In one example, when we use the relay module to open our office lamp, the PIR sensor
to detect the pet will give HIGH output. For this issue, we can use another breadboard that a 5V 1A
charger can power up, and while the devices’ digital and analog pins are connected to the ESP